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Wichtig!!! 

 

 

 

Falls Sie als Fahrleiter oder Sondenoperator  

- eine Schulung benötigen  

- sich einen Extra Sonden Check-up vor der Reise wünschen** 

- technische Unterstützung brauchen 

- extra Sensoren anbringen wollen 

- Sonderwünsche (Probenentnahme, höhere Datenauflösung usw.) haben 

- Fragen oder Probleme haben (komische Profile, Fehlermeldungen, 

fehlerhafte Messwerte usw.) 

 

können Sie sich jeder Zeit bei der ozeanographischen Arbeitsgruppe im SF 

melden: 

 

sf-oceanography@thuenen.de 

 

Telefonisch erreichen Sie uns unter: 

 

Andriy Martynenko:  0471/ 94460 - 223 

Annika Elsheimer:   0471/ 94460 - 242 

Anna Akimova:   0471/ 94460 - 253 

 

 

 

** alle Sonden werden von uns regelmäßig (1 Mal in 2-3 Monate) gecheckt.  
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Vor der Reise bzw. vor der ersten Station 
 

Vorbereitung Flaschenkisten: 

 

- Holzkisten an einem vor Wasser geschützten Platz aufstellen, damit 

die Kisten nicht durch Salzwasser feucht werden, Metallteile 

korrodieren und das Holz aufquillt. 

 

- Kisteninhalt auf Verunreinigungen und Absplitterungen prüfen, falls 

vorhanden Flasche bitte nicht verwenden! 

 

Sondenvorbereitung und Sondenreinigung: 

 

- Abdeckhaube entfernen 

- vor der ersten Station die Sensorenzelle mit De-Ionized Wasser füllen. 

Dauer: 1 Stunde (s. Sondenreinigung nach jeder Station, Seite 22) 

 

Testlauf (Dry test) 

 
ACHTUNG !!!  Wasserschöpfer können beschädigt werden, wenn sie im 

Trockenen ausgelöst werden! Deswegen müssen Wasserschöpfer während 

des Testlaufes geschlossen sein.    
 

 

- Deckunit einschalten. Die Deckunit der Sonde befindet sich im 

Ozitrockenlabor auf WHIII (Abb. 1, Seite 5)  

- Kontrollleuchte überprüfen 

Auf Herwig Deckunit SBE11: 

 

 Fenster Underwater Unit „Data“ leuchtet 

 Fenster Computer Deckunit „NMEA“ leuchtet (falls Data 

Acquition gestartet ist, leuchtet „Transmit“) 

 Fenster „Water Sampler Control“, „SBE“ und „Carrier“ 

leuchten. 

 Wenn die Pumpe aus ist (Pumpe Off) und der Schalter auf 

“B”, steht im „Word Display“ „0010“, wenn die Pumpe an ist 

(Pumpe On) und der Schalter auf “B”, zeigt „Word Display“ 

„0011“. 
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 SeasaveV7 öffnen und Software einstellen (s. Seasave Einstellungen f. 

Testlauf, Seite 6) 

 Angezeigte Werte überprüfen (s. Testwerte, Seite 8) 

 Wasserschöpfer testen (s. Wasserschöpfer Test, Seite 9) 

 

 

 

 
Abb. 1. Deckunit SBE11 auf WHIII 
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Seasave Einstellungen für Testlauf 

 

 

1. Seasave öffnen. Üblicherweise wird der passende .psa-File automatisch 

geladen. Wenn nicht s. „Datenaufnahme mittels Seasave“, Seite 14. 

 

2. Man kann die beiden Plot-Diplays und das Fixed Display über rechten 

Mausklick Modify im Messbereich anpassen und weitere Parameter (z.B. 

Sauerstoff, Trübung usw.) auswählen 

 

3. Real-Time-Data → start… drücken. Im Pop-Up Fenster Begin 

archiving data immediatly auswählen (Abb. 2, Seite 7). 

 

4. Im gleichen Fenster unter SelectOutputDataFileName Zielort und 

Namen der Datei eingeben.  

Der Dateiname setzt sich aus Schiffskürzel + Reisenummer+“test“ 

zusammen, Bsp.: HC999test.hex. 

 

5.  Start drücken, Header Information wird geöffnet. Ship, Station, 

Operator eingeben (als Station kann man „test“ benutzen) und auf OK. 

Die Verbindung zur Sonde wird aufgebaut und die Datenaufzeichnung 

beginnt. 
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Abb. 2. Data Acquisition Fenster 
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Sensoren Testwerte 

 

Prüfen ob die Sensoren die zu erwartenden Werte anzeigen: 

 

- Depth (Salt water, m) sollte ungefähr „0“ sein 

- Potential Temperature sollte Luft-/Raumtemperatur anzeigen 

- Salinity sollte „0“ zeigen 

 

Falls weitere Parameter ausgewählt wurden: 

- Fluorescence: der Wert sollte sich verändern, wenn man einen 

Gegenstand in den Messstrahl hält 

- Turbidity: der Wert sollte nahezu 0 FTU sein und sich verändern auf 

20-50 FTU, wenn man die Hand dicht unter den Sensor hält 

 

 

Falls die Werte von o. genannte stark abweichen, melden Sie sich bitte 

telefonisch oder bei: 

 

 sf-oceanography@thuenen.de  
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Wasserschöpfer testen  

 

ACHTUNG !!!  Wasserschöpfer können beschädigt werden, wenn sie im 

Trockenen ausgelöst werden! Deswegen müssen Wasserschöpfer 

geschlossen sein. 

 

 

1. Prüfen ob die Häkchen leichtgängig sind, aber festsitzen, wenn sie 

eingespannt sind 

2. Die Häkchen alle einspannen 

3. Über das Fenster FireBottleControl Häkchen für Schöpfernummer 1 

auslösen 

 

 
 

4. Man muss ein leises Klicken hören und das Häkchen muss nun frei 

beweglich sein 

5. Dies bei allen Schöpfernummern testen 

6. Mit Real Time Data → Stop… beendet man die Aufzeichnung 

7. Deckunit ausschalten!!! 

 

ACHTUNG!!!! Unbedingt nach jeder Station oder Testlauf Deckunit 

wieder ausschalten, da sonst die Pumpe trocken läuft und dies zu massiven 

Schäden führt.  
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Auf Station 
 

Aus Sicherheitsgründen muss folgende Schutzkleidung getragen werden: 

 

1. Helm 

2. Sicherheitsweste (welche mit der Sicherungsleine am Schott 

verbunden wird) 

3. festes Schuhwerk 

 

Station benennen: 

 
Schiffskürzel + Reisenummer + Schiffsstationsnummer, 

 

ist am linken Rand des Datadismonitor ablesbar (Abb. , Seite 19) 

 

 

Beispiel:   HC280786    

Keine Leerzeichen dazwischen oder Unterstriche einfügen. 

 

Es ist wichtig, dass die Stationsnummer vom Schiff genommen wird, damit man 

die Station später in den Datadisaufzeichnungen wiederfinden kann. 

 

ACHTUNG!!!  Die Stationsnummer und der Filename müssen identisch 

sein!!! 

 

Schiffskürzel:    HC= Walther Herwig III SB=Solea CB=Clupea 
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Messverfahren 

 

Achtung!! Schutzschläuche (z.B. Tygonschlauch, Abb.13, Seite 24) und 

andere mögliche Spülzubehöre (z.B. Abb.11, Seite 23) von der Sonde 

entfernen. 

 

1. Wasserschöpfer spannen (Achtung!! Die Flaschen sollen offen sein, 

auch wenn keine Wasserproben genommen werden. Das 

Runterfahren mit geschlossenen Flaschen beschädigt diese. Man 

kann auch alle Schöpfer abbauen, wenn sie nicht gebraucht werden). 

 

2. Lüftungsschrauben und Hähne schließen (Scheibe muss rausgezogen sein)  

- s. Abb. 3, Seite 13 

 

3. Deckunit einschalten. 

 

4. Seasave öffnen, der gespeicherte .psa-File wird automatisch geladen bzw. 

selbst das Display einstellen (s. „Datenaufnahme mittels Seasave“, Seite 

14). 

 

5. Real-Time-Data → start… drücken. Im Pop-Up Fenster Begin 

archiving data immediatly auswählen (Abb. 2, Seite 7). 

 

6.  Unter SelectOutputDataFileName Zielort und Namen der Datei 

eingeben.  

Der Dateiname setzt sich auf Schiffskürzel + Reisenummer + 

Stationsnummer zusammen, z.B. HC999360.hex (s. Station 

benennen). Hierbei ist darauf zu achten, dass die Stationsnummer 

identisch mit der Schiffsstationsnummer ist! 

 

7. Start drücken, Header Information wird geöffnet. Ausfüllen und auf OK.  

Die Verbindung zur Sonde wird aufgebaut und die Datenaufzeichnung 

beginnt. 

 

8. Sonde ins Wasser lassen 

 

9. Sonde mindestens 2 Minuten in 2m bis 10 m Tiefe hängen lassen bis 

Pumpe anspringt (Pumpstatus muss auf „ON“ stehen) und Sonde somit 

messbereit ist. Die Messung sollte so oberflächennah wie möglich 

beginnen um auch diese Werte erfassen zu können, allerdings ist dies 
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abhängig vom Seegang, die Sonde muss auf jeden Fall immer komplett im 

Wasser sein! 

 

Achtung!! Falls Pumpe wegen zu vielen Luftblasen nicht anspringt, 

Sonde noch tiefer fieren und warten bis Pumpe anspringt! 

 

10. Stationsprotokoll ausfüllen (s. Stationsprotokoll, Seite18) 

 

11. Temperatur, Salzgehaltswerte und Pumpenstatus kontrollieren. 

Temperatur und Salzgehalt müssen konstant sein und der Pumpstatus auf 

„ON“ stehen.  

 

Die Messung ist unbrauchbar wenn die Pumpe nicht läuft!!! 

 

12. Die Sonde wieder an der Oberfläche bringen, damit man das komplette 

Messprofil von der Oberfläche bis zum Boden bzw. gewünschte Tiefe 

bekommt.  

 

13. Kommando: „Fier weg mit 1m/s“ 

 

14. Ca. 5m über Grund (Altimeteranzeige) Kommando: „Stopp“ 

 

15. Max. Messtiefe und Uhrzeit der Profildauer in Protokoll eintragen 

 

16. Kommando: „Hieven“ 

 

17. Falls Wasserproben benötigt werden, wählt man die Tiefe mit dem 

geringsten Salzgehaltsgradienten während des Downcast. Während des 

Upcast wird der Wasserschöpfer in den gewünschten Tiefen gestoppt, 2-3 

Minuten warten und die Schöpfer schließen (über das Fenster 

FireBottleControl in Seasave).  

 

Achtung!!!  Die Proben sollen nicht nah am Meeresboden genommen 

werden (sonst verschlechtert sich die Datenqualität wegen der 

Trübung). Nach Möglichkeit sollen die Proben mindestens 50 m über 

den Boden genommen werden, in flachen Gebieten - nicht näher als 

5-7 m zum Boden. Bevor die Schöpfer geschlossen werden, muss man 

2-3 min in gewünschter Tiefe die Sonde anhalten, damit sich die 

Sensoren und das Wasser im Schöpfer thermodynamisch 

stabilisieren. 

 

18. Wenn die Sonde aus dem Wasser kommt, die Datenaufzeichnung in 

Seasave beenden (über Real Time Data → Stop) 
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19. DECKUNIT AUSSCHALTEN! 

 

20. Sonde an der Luke in Empfang nehmen 

 

21. Alle 4 Dateien (.hex-File, .con-File, .hdr-File, .bl-File) pro Station noch 

mal in einen Backup Ordner oder USB-Stick kopieren 

 

 

22. Wasserproben entnehmen (s. „Probenentnahme für Salzgehaltsproben“, 

Seite 21) 

 

23. Sonde reinigen (s. „Sondereinigung nach jeder Station“, Seite 22) 

 

24. Vor längeren Stehzeiten der Sonde oder beim Transport ist darauf zu 

achten, dass die Wasserschöpfer NICHT gespannt sind! 

 

25. Sobald die Sonde nicht täglich genutzt wird oder von Schiffsseite 

Arbeiten im Schöpferraum anstehen immer die Abdeckhaube 

darüber ziehen. 

 

ACHTUNG!!!! Unbedingt nach jeder Station das Deckunit wieder 

ausschalten, da sonst die Pumpe trocken läuft und dies zu massiven 

Schäden führt.  

  
Abb. 3. Wasserschöpfer.  

 

Lüftungsschraube 

Hahn 
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Datenaufnahme mittels Seasave 

 
SeasaveV7 ist ein Programm von Seabird um Echtzeitdaten (von Sonden) 

aufzunehmen und anzeigen zu lassen. Es können aber auch archivierte Daten 

angezeigt werden. Nachfolgende Beschreibung gilt für Version SeasaveV7.20c: 

 

 

1. Unter File → Open Setup File → C:/WHxxx/Psa_Files/ passenden .psa-

File zur Sonde öffnen. File hat die 4-stellige Gerätenummer und die 

Gerätenummer steht auf dem Seabirdlabel des Sondengehäuses. Bsp.: 

0809 (Abb. 44, Seite 15)  

 

2. Unter Configure Inputs → Instruments Configuration → Open (Abb. 

5, Seite 15) immer den .xmlcon oder .con-File zur entsprechenden Sonde 

auswählen .xmlcon oder .con-File hat die 4-stellige Gerätenummer und 

die Gerätenummer steht auf dem Seabirdlabel des Sondengehäuses. Bsp.: 

0809.xmlcon oder 0809.con 

 

ACHTUNG!! Im .xmlcon oder .con-File stehen alle Kalibierungswerte für 

die einzelnen Sensoren, die dürfen in diesem File nicht geändert werden! 

 

 

3. Darauf achten, dass NMEA position data added auf YES steht (Abb. 6, 

Seite 16). Falls nötig über Modify die NMEA-Einstellung ändern, indem 

man das Häkchen setzt und NMEA device connected to deck unit 

auswählt (Abb. 7, Seite 16). 

 

4. Zurück zum Schritt 5 in ‚Messverfahren‘ 
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Abb. 4. Default setup für Seasave (Seasave_7_20.psa) 

 

 

 
Abb. 5. Konfiguration File auswählen.  
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Abb. 6. NMEA Einstellung im .con File. 

 
 

 

Abb. 7. Ändern NMEA Einstellungen 
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Seasave Display Einstellungen 

 

Unter Display wählt man folgende Fenster aus: 

 

- Plot Display, zum anzeigen des Profils 

- Fixed Display, zum Anzeigen der aktuellen Messwerte als Standmodus 

 

 

Mit rechtem Mausklick auf dem jeweiligen Fenster kann man unter Modify die 

benötigten Parameter und Messbereiche auwählen/einstellen. 

 

Unter Real Time Control → Fire Bottle Control auwählen, dann öffnet sich 

das Fenster zum Auslösen der Wasserschöpfer 

 

Neue .psa-Datei kann man an beliebigen Ort speichern, aber bitte das  

C:/WHxxx/Psa_Files/Seasave06102015_0809.psa(vorbereitete optimale 

Einstellungen für unsere Sonde) nicht überschreiben! 
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Stationsprotokoll 

 
Abb. 8. CTD-Sonden Protokoll. 

 

Folgende Parameter kann man vom Datadismonitor ablesen (Abb. 9, Seite 19): 

 

 Schiff/Reisenummer 

 Stationsnummer 

 Datum 

 Koordinaten 

 Uhrzeit UTC: Profildauer, „von“ bedeutet Start ist Kommando „Fieren“, 

„bis“ bedeutet, dass Sonde tiefsten Meßpunkt erreicht hat 
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 Gelotete Tiefe 

 Windrichtung und –geschwindigkeit 

 Lufttemperatur und –feuchtigkeit 

 Luftdruck 

 

Die meteorologischen Daten wie Wetter, Bewölkung, See und Eisverhältnisse 

muss man selber bestimmen, man steht an der Sonde bei der Luke und kann 

einen Blick nach draußen riskieren um zu sehen ob es zum Beispiel schneit oder 

regnet, wie hoch die Wellen sind, ob es bewölkt ist oder ob Eisberge in der Nähe 

sind. (Wettercode-Tabellen Abb.10, Seite 20)  

Wichtig ist auch, dass man die Flaschennummer zur passenden 

Schöpfernummer einträgt! 

 

 

 

 

 
Abb. 9. Datadis Bildschirm 
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Wettercode 

 
Abb. 10 Wettercode-Tabellen 
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Probenentnahme für Salzgehaltsproben 

 

ACHTUNG!!! Die Probennahme muss sehr sorgfältig und genau wie 

beschrieben durchgeführt werden. Besser keine Probe, als falsch 

genommene Probe. 

 

1. Flasche 3-mal spülen: 

 

- Lüftungsschraube öffnen. 

 

- Hahn öffnen (Scheibe reindrücken indem der Stift am Schöpfer 

durch das Loch in der Scheibe geführt wird), Flasche unter den 

freien Wasserstrahl halten (ohne, dass der Schlauch die 

Flaschenöffnung berührt) und etwa zu einem Drittel füllen, Hahn 

schließen, Flasche kurz schütteln und über den Schlauch ausgießen. 

Zweimal wiederholen. 

 

2. Flasche endgültig füllen, dabei max. nur bis 1cm vor unterem Rollrand 

 

 

 
 

3. Gewinde und oberen Abschluss mit einem sauberen trockenen 

Papiertuch sorgfältig abwischen, so dass kein Salzwasser im Gewinde 

und der planen Fläche verbleibt!!! 

 

4. Kunststoffstopfen vollständig bis zum Anschlag in den Flaschenhals 

drücken. Kappe aufschrauben und die Flasche in der richtigen 

Reihenfolge in die Kiste stellen. 

 

5. Kistenummer und Flaschenummer im Protokoll notieren, 

Flaschennummer zur dazugehörigen Schöpfernummer notieren. 

 

Volle Kiste an geschütztem Ort lagern. 

unterer Rollrand 

 

maximale Füllhöhe 
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Sondenreinigung nach jeder Station. 

 

Wer sich bei der Sondenreinigung unsicher ist oder zum ersten Mal mit der 

Sonde arbeitet kann eine Schulung bekommen (nach Vereinbarung, s. Seite 2). 

Bei Fragen und Probleme sind wir jederzeit (auch während der Reise) unter 

folgende Emailadresse zu erreichen: 

 

sf-oceanography@thuenen.de 

 

 

1. Die komplette Rosette und Sonde mit Süßwasser gründlich abspülen. 

 

2. Die Sensorzelle mit Triton 0.1% spülen (Abb.11, Seite 23). Dazu 

Spritze einmal mit Triton 0.1% aufziehen. Schlauch über 

Sensoreingang stülpen und Spritze 2 bis 3 Mal leeren und wieder 

ansaugen (d.h. Kolben hochziehen und runterdrücken) 

 

ACHTUNG!!! Die Tritonlösung darf sich nicht länger als eine 

Minute in der Sonde befinden. 

 

3. Die Sensorzelle 30sec mit Süßwasser durchspülen, Süßwasserschlauch 

direkt auf den Sensoreingang drauf setzten und Wasser laufen 

lassen(Fehler! Verweisquelle konnte nicht gefunden werden.12, S

eite 23) oder Sensorzelle per süßwassergefüllter Spritze durchspülen 

(Abb.11, Seite 23). 

 

4. Tygonschlauch über Sensoreingang und Pumpenausgang stülpen, 

somit ist die Sensorzelle geschützt (Abb.13, Seite 24). 

 

  

mailto:sf-oceanography@thuenen.de
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Abb. 11. Sensorzellenreinigung mit Spritze (Tritonlösung, Süßwasser oder De-

Ionized Wasser). 

 

 
Abb. 12. Sensorzellenreinigung mit Süßwasserschlauch 
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Abb. 13. Stellung des Tygonschlauches. 

 

  

Tygonschlauch 

Pumpenaus-

gang 



25 

 

Routinereinigung (1-mal pro Woche): 

 

Wer sich bei der Sondenreinigung unsicher ist oder zum ersten Mal mit der 

Sonde arbeitet kann eine Schulung bekommen (nach Vereinbarung). Bei Fragen 

und Probleme sind wir auch jederzeit (auch während der Reise) unter folgende 

Emailadresse zu erreichen: 

 

sf-oceanography@thuenen.de 

 

1. Die komplette Rosette und Sonde mit Süßwasser gründlich abspülen. 

 

2. Die Sensorzelle mit Triton 1% spülen (Abb.11, Seite 23). Dazu Spritze 

einmal mit Triton 1% aufziehen. Schlauch über Sensoreingang stülpen 

und Spritze 2 bis 3 Mal leeren und wieder ansaugen (d.h. Kolben 

hochziehen und runterdrücken) 

 

ACHTUNG!!! Die Tritonlösung darf sich nicht länger als eine 

Minute in der Sonde befinden. 

 

3. Die Sensorzelle 30sec mit Süßwasser durchspülen, Süßwasserschlauch 

direkt auf den Sensoreingang draufsetzten und Wasser laufen lassen 

(Abb.12, Seite 23) oder Sensorzelle per süßwassergefüllter Spritze 

durchspülen (Abb.11, Seite 23). 

 

4. Die Sensorzelle mit Bleichmittel 0,1 – 0,05% (Natriumhypochlorit) 

Lösung spülen. Spritze einmal mit Bleichmittel aufziehen. Schlauch 

über Sensoreingang stülpen und Spritze 2 bis 3 Mal leeren und wieder 

ansaugen (d.h. Kolben hochziehen und runterdrücken) 

 

ACHTUNG!!! Das Bleichmittel darf sich nicht länger als eine 

Minute in der Sonde befinden. 

 

5. Die Sensorzelle 30sec mit Süßwasser durchspülen, Süßwasserschlauch 

direkt auf den Sensoreingang draufsetzten und Wasser laufen lassen 

(Abb.12, Seite 23) oder Sensorzelle per süßwassergefüllter Spritze 

durchspülen (Abb.11, Seite 23). 

 

6. Tygonschlauch über Sensoreingang und Pumpenausgang stülpen, 

somit ist die Sensorzelle geschützt (Abb.13, Seite 24) 
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Ende der Reise 
 

 

Sondenreinigung am Ende der Reise: 

 

1. Routinereinigung durchführen (s. „Routinereinigung“, Seite 25) 

Wenn die Sonde sichtbare Verschmutzung aufweist: 5-mal 

Routinereinigung wiederholen 

2. Gründlich mit De-Ionized  Wasser durchspülen (Fehler! V

erweisquelle konnte nicht gefunden werden.11, Seite 23) 

3. Trocknen lassen 

4. Tygonschlauch über Sensoreingang und Pumpenausgang stülpen, 

somit ist die Sensorzelle geschützt (Fehler! Verweisquelle konnte nicht g

efunden werden.13, Seite 24) 

5. Abdeckhaube über die Sonde ziehen 

 

Achtung!!! Bei Frosttemperaturen ist darauf zu achten, dass die Sensorzelle 

trocken ist um die Sensoren vor Frostschäden zu bewahren. 

 

Nach der Reise die Daten (4 Files pro Station - .hex, .hdr, .con, .bl), Protokolle 

und Flaschenkisten bei der ozeanographischen AG im SF abgeben. 

 

Die Daten können per Mail an sf-oceanography@thuenen.de gesendet werden.  

 

Die Protokolle entweder persönlich abgeben oder per Post an: 

 

Annika Elsheimer oder Andriy Martynenko 

 

TI-SF 

Herwigstraße 31 

57572 Bremerhaven 

 

Die Flaschenkisten müssen bei Annika Elsheimer oder Andriy Martynenko 

abgegeben werden. 

mailto:sf-oceanography@thuenen.de
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Troubleshooting.  
 

Ersthilfe zur Behebung kleiner Fehlfunktionen der SBE9Plus und Deckunit 

11Plus 

 
!!!WARNUNG!!! 

Wenn die Deckunit 11Plus eingeschaltet ist, liegen gefährlich hohe 

elektrische Spannungen auf einigen Steckerverbindungen der SBE 9Plus 

(CTD Sonde) und 11Plus (Deckunit). Auf Grund der 

Kondensatorspeicherung können diese auch noch einige Zeit, nachdem die 

Deckunit ausgeschaltet ist, bestehen bleiben. Vor Arbeiten an sowohl CTD 

als auch Deckunit ist daher der Netzstecker zu ziehen und eine Wartezeit 

von 60 Sekunden einzuhalten. 

 

!!!WARNUNG!!! 

Wenn die Sonde 9plus während eines Unterwassereinsatz ausfällt und/oder 

andere Zeichen von Schäden durch Wassereinbruch vorliegen, solange 

sicheren Abstand zum Gerät halten, bis sichergestellt wurde, dass kein 

abnorm hoher Innendruck in geschlossenen Teilen der Sonde vorliegt 

(Explosionsgefahr!). 

 

 

Probleme 1. Sensoren liefern falsche bzw. unglaubwürdige 

Messwerte. 

 

Bedeutung:  

 

Jede SBE 9plus wird mit einer spezifischen Konfigurationsdatei (*.xmlcon oder 

*.con) ausgeliefert. Diese enthält die spezifische Konfiguration des Geräts 

(Anzahl und Art der Sensoren, etc.) sowie die Kalibrierungskoeffizienten.  

Fehlerhafte bzw. unglaubwürdige Werte können durch falsche Konfiguration 

des Messinstruments in der .xmlcon oder .con Datei erzeugt werden.  

 
Hilfe: 

 

 Sicherstellen, dass die richtige zur Sonde gehörige Konfigurationsdatei 

(*.xmlcon oder .*.con) geladen wurde. Die richtige Konfigurationsdatei 

kann man per Email nachfragen: sf-oceanography@thuenen.de . 

 

 Anschlusskabel der Sensoren sind defekt. Defekte Anschlusskabel können 

ebenfalls bei der Übertragung der Messwerte Probleme erzeugen und zu 

mailto:sf-oceanography@thuenen.de
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falschen Messwerten führen. Die Kabel sollten daher bei solchen 

Problemen überprüft und ggf. ersetzt werden. 

 

 

 

Probleme 2: Die Pumpe springt nicht an oder funktioniert nicht. 

 

(bitte Warnungen auf der Seite 27 lesen!!!) 

 

Beschreibung:  

 

Die SBE 9plus hat eine fest voreingestellte Pumpenverzögerung, die durch die 

erste Leitfähigkeitsmesszelle gesteuert wird. Pumpe schaltet sich automatisch 

an, wenn die folgenden BEIDEN Bedingungen erfüllt sind: 

 

1. Die erste Leitfähigkeitsmesszelle ist mit Seewasser gefüllt, so dass die 

erzeugte Frequenz der Zelle über die Einschalt-Frequenz der Pumpe 

steigt. Salzgehalt liegt über 3-5 PSU 

 

2. Die 60-Sekunden Einschaltverzögerung der Pumpe ist abgelaufen. Damit 

soll sichergestellt werden, dass sämtliche im System verbliebenen 

Luftreste über das Entlüftungsloch entweichen können. 

  
 
Hilfe:  

 
Für die Funktionstüchtigkeit der Pumpe muss sichergestellt sein, dass sämtliche 

Anschlusskabel in Ordnung und richtig gesteckt sind. Vor jeder Station ist 

sicherzustellen, dass die Schutzschläuche vollständig entfernt wurden. 

 
 
Die Funktionstüchtigkeit der Pumpe und deren Anschlüsse kann auf folgende 

Weise überprüft werden: 

 

Sollte die Sonde nicht nach spätestens 3 Minuten im Seewasser anspringen, 

kann es sein, dass sich noch eine Luftblase in der ersten Leitfähigkeitszelle 

befindet und das Erreichen der Auslösefrequenz verhindert. Die Luftblase kann 

dann meist mit Hilfe des sog. Deep Soak ausgetrieben werden. Dazu wird die 

Sonde auf 10 – 20 m Wassertiefe weggefiert und eine Weile hängen gelassen. 

Der Wasserdruck in dieser Tiefe reicht aus, die Luftblase aus dem System zu 

drücken und die Pumpe springt nach Ablauf der Einschaltverzögerung an. Das 
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Gerät wird dann zurück an die Oberfläche geholt und danach das Profil 

gefahren. 

 

Man kann die Pumpe aber auch mit einem Funktionstest an Deck prüfen: 

 

Verbinden Sie die Sonde über das Seekabel mit der Deckunit. (Anschluss Sonde 

s. Abb.15, Seite 33- Anschluss Deckunit s. Abb.14, Seite 32) Schalten sie die 

Deckunit ein. Befüllen Sie die erste Leitfähigkeitszelle (Conductivity Sensor 1) 

mit Seewasser (Spritze benutzen). Erste Leitfähigkeitszelle ist mit dem 

Sauerstoffsensor (SBE43) verbunden. Sie kann auch mit Hilfe des Kabels 

gefunden werden (Abb. 16, Seite 34). Verschließen sie bitte den unteren Auslauf 

(z.B. mit dem Tygonschlauch). Nach etwa 60 Sekunden sollte die Pumpe 

anspringen. Man hört ein leises Geräusch des Pumpenmotors. 
 

 

 

 

Probleme 3. Wasserschöpfer und/oder CTD reagieren nicht 

 

Beschreibung: 

 

Man bekommt eine Meldung von SeaSave: „Data acquisition is cancelled – 

failed to initialize the water sampler“. Folgende Gründe können dafür 

verantwortlich sein: 

1) Es ist keine Spannung auf dem Seekabel 

2) Ein Kurzschluss ist auf dem Seekabel 

3) Die Sonde ist defekt 

 

 

Hilfe:  

Achtung!!! Grundsätzlich: bei Problemen mit der Stromversorgung ist 

immer der SET (Schiffselektriker) hinzuzuziehen.  
 

Zusammen mit dem SET sollten folgende Punkte überprüft werden: 

 

 

1. ob die SBE 9plus durch die Deckunit SBE 11plus mit Strom versorgt 

wird. Dazu geht man wie folgt vor: 

 Ausschalten der Deckunit und ziehen des Netzsteckers. 

 Trennen der Verbindung Deckunit-Seekabel an der Rückseite des 

SBE 11plus.(Abb.14, Seite 32) 
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 Mindestens 1 Minute warten 

 Netzstecker wieder einstecken, Deckunit einschalten. 

 Mit einem Voltmeter (Bereich mindestens 300 Volt DC) wird die 

Spannung, die an der Seekabelsteckverbindung auf der Rückseite 

des SBE 11plus anliegt, gemessen. !!!Vorsicht!!! Diese sollte 

250V betragen. 

 

2. Entspricht die Spannung 250 V, ist entweder die Verbindung zur Sonde 

über das Seekabel gestört oder die Sonde ist defekt. Die 

Funktionstüchtigkeit der Sonde kann mit dem an Bord vorhandenen 

Testkabel überprüft werden. Dazu wird bei ausgeschalteter Deckunit die 

Sonde über das Testkabel mit der Deckunit verbunden. (Anschluss Sonde 

s. Abb.15, Seite 33- Anschluss Deckunit s. Abb.14, Seite 32) Nach 

Einschalten der Deckunit wird versucht, über das SeaSave Programm 

Daten abzufragen. Liefert die Sonde Daten, bzw. nimmt das SeaSave 

Programm die Datenaquirierung (Acquisition) auf, ist die Sonde in 

Ordnung und es liegt ein Fehler am Seekabel. Dies muss auf Schäden 

geprüft werden und ggfs gekürzt werden. Diese Terminierung darf nur 

der Schiffselektriker! 

 

3. Gibt die Deckunit keine 250 V Spannung ab, dann ist vermutlich die 

Sicherung der Seekabelstromversorgung durchgebrannt. Dazu wird die 

Deckunit ausgeschaltet und der Netzstecker gezogen. Nach 1 Minute kann 

die Sicherung (SEA CABLE FUSE 0.5AMP ) aus ihrer Halterung 

gedreht (Abb. 14 ,Seite 32) und überprüft werden. Ist sie durchgebrannt, 

wird sie durch eine entsprechende Sicherung ersetzt.  

ACHTUNG!!!! Ursache einer durchgebrannten Seekabelsicherung ist 

meist ein Kurzschluss im Seekabel. Daher sollte sogleich, und bevor 

es wieder an die Deckunit angeschlossen wird, das Seekabel auf 

Kurzschluss überprüft werden. Dies darf nur der Schiffselektriker! 

Meist ist auch hier der Übergang zum SubConn Adapterstecker defekt 

und muss ersetzt werden. 

 

4. Sind Seekabel und Stromversorgung der Sonde in Ordnung und die Sonde 

liefert dennoch keine Daten, ist die Sonde defekt und muss gegen das 

Ersatzgerät getauscht werden.  
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Abb. 14. Rückseite der Deckunit  

SBE 11plus. 
Sicherung Anschluss Seekabel 
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Abb. 15. SBE9plus Anschlüsse der oberen Endkappe. 

Anschluss Seekabel 
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Abb. 16. SBE9plus Anschlüsse der unteren Endkappe. 

 


